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Important Notice

TaiRox does not warrant or represent that your use of this software product will be uninterrupted or error-free or that
the software product can be run with any version of Sage 300 other than recent versions listed on the TaiRox
website, or that the information in this document is completely accurate. TaiRox warrants that any media by which you
have received this software is free from defects. TaiRox will replace any such defective media. TaiRox expressly disclaims
all other warranties, representations, conditions and guarantees of any kind including, but not limited to, warranties for
merchantability or fithess for a particular use.



Installing Productivity Tools The Distribution Files

Installing Productivity Tools

TaiRox Productivity Tools conforms to standard Windows installation and removal protocols.

You must install Sage 300 before you install Productivity Tools.

Important Note: When upgrading, uninstall the previously installed version of
Productivity Tools using the Windows Control Panel before installing the new version.

The Distribution Files
TaiRox Productivity Tools for the Sage 300 Desktop is distributed as 2 files, “Setup-2018-
2025.msi” and “Setup-2012-2017.msi”.

¢ Setup-2018-2025.msi — installs Productivity Tools on the Sage 300 Desktop — for Sage
300 version 2018 or later.

o Setup-2012-2017.msi — installs Productivity Tools on the Sage 300 Desktop — for Sage
300 version 2017 or earlier.

If you use Sage 300 Web screens, you can also install Productivity Tools Web screens for
Sage 300. The Web screens are launched from Sage 300cloud running in a Web browser.

Sage 300cloud web screens are version-specific. You must install web screens that
match your version of Sage 300.

e Sage 300 version 2024 0 for the original release of Sage 300 2024

o TPTWeb 2024 0 setup.msi -- installs Web Screens

o TaiRoxXLOrderEntry_2024 0.zip -- customizes Order Entry screen

o TaiRoxXLShipmentEntry_2024 0.zip -- customizes Shipment Entry screen
e Sage 300 version 2023_3 for Sage 300 2023.3 (PU3)

o TPTWeb 2023 3 setup.msi -- installs Web Screens

o TaiRoxXLOrderEntry_2023_3.zip -- customizes Order Entry screen

o TaiRoxXLShipmentEntry_2023_3.zip -- customizes Shipment Entry screen
e Sage 300 version 2023_1 for Sage 300 2023.1 (PU1)

o TPTWeb 2023 1 setup.msi -- installs Web Screens

o TaiRoxXLOrderEntry_2023 1.zip -- customizes Order Entry screen

o TaiRoxXLShipmentEntry 2023 1.zip -- customizes Shipment Entry screen
e Sage 300 version 2023_0 for the original release of Sage 300 2023

o TPTWeb 2023 0 setup.msi -- installs Web Screens

o TaiRoxXLOrderEntry_2023 0.zip -- customizes Order Entry screen

o TaiRoxXLShipmentEntry_ 2023 0.zip -- customizes Shipment Entry screen
e Sage 300 version 2022_2 for Sage 300 2022.2 and higher (e.g. PU2, PU3)

o TPTWeb 2022 2 setup.msi -- installs Web Screens

o TaiRoxXLOrderEntry 2022 2.zip -- customizes Order Entry screen

o TaiRoxXLShipmentEntry_2022_2.zip -- customizes Shipment Entry screen
e Sage 300 version 2021_2 for Sage 300 2021.2 and higher (e.g. PU5, PUG)

o TPTWeb 2021 _2 setup.msi -- installs Web Screens

o TaiRoxXLOrderEntry_2021_2.zip -- customizes Order Entry screen

o TaiRoxXLShipmentEntry_2021_2.zip -- customizes Shipment Entry screen

TaiRox Productivity Tools for Sage 300 1
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You import the Order Entry and Shipment Entry customization using the Sage 300 Web Admin
Configuration application

When installing Productivity Tools, keep the following points in mind.

You must install the Productivity Tools using “Setup-2018-2025.msi” or “Setup-2012-
2017.msi” on each computer where Sage 300 is physically installed.

If you have one or more RDP servers and use workstation setup, make sure that you
install Productivity Tools on all RDP servers — and run RegAcc.exe on each workstation
that runs Sage 300 from a server (or run Workstation Setup with “repair”).

You must activate Productivity Tools using the Sage 300 Activation program for each
company that uses Productivity Tools.

To use TaiRox Productivity Tools Web Screens features, you must:

o Install Productivity Tools Web Screens where Sage 300 Web Screens are installed.

o Import all Productivity Tools customizations for Sage 300 Web screens using the
Sage 300 Web Admin Configuration application.

New Features in Productivity Tools

TaiRox continually adds new features to Productivity Tools. For example, the following features
were added to TaiRox Productivity Tools from December 2021 to August 2022.

See the Release Notes on the Productivity Tools product page on the TaiRox Website for up-to-
date changes.

TaiRox Productivity Tools for Sage 300

Apply Documents now has a Document Order drop-down so payments can be applied
by Invoice Date, by Due Date, or by Document.

Ship Orders includes the FOB Point field in the drop-down list for range filtering.

Update Orders, Substitute Items, now provides an option to retain the original item,
zeroing its quantity on an order. Update Orders also has a new option: Update Ship Via.

Invoice Shipments now displays the tracking number in the shipments grid.
Extended PO Invoice Entry lets you select receipts from multiple vendors.
The Extended Order Entry “Ship” pop-up now lets you edit Quantity on Order.

A new program, Copy G/L Accounts, was added for Productivity Tools Enterprise
licenses.

Two new programs, Create A/R Credit Notes and Create O/E Credit Notes, allow you to
create credit notes for multiple A/R invoices and O/E invoices in one step.

Extended Order Entry, Create Purchase Orders, lets you set the expected arrival date.

Productivity Tools supports the Advanced Complex Passwords feature added in Sage
300 2022 PU2.

Extended Customers and Extended Vendors copies customers and vendors to other
company databases regardless of whether the source and target company's functional
currency match, or they are multicurrency or not.

A new program, Email Packing Slips, will send emails to customers reporting which
items on an order were shipped.

© TaiRox Software Inc. All rights reserved.
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Preparation & Planning, Prior to Software Installation

Read this document and create an upgrade plan. The plan should include the following items.

1.

Prepare a list of all servers and workstations that will require software upgrades:

o All computers where Productivity Tools is installed.
o All computers that run Sage 300 applications, including the server for Sage 300 Web
Screens.

The Productivity Tools installation packages include the following installation files for
Productivity Tools 2018-2025:

Setup-2018-2025.msi

TPTWeb_2024 0_setup.msi

TPTWeb_2023_3_setup.msi

TPTWeb_2023_1_setup.msi

TPTWeb_2023_0_setup.msi

TPTWeb_2022_2 setup.msi — for Sage 300 2022 (PU2 and higher)
TPTWeb_2021_2_setup.msi — for Sage 300 2021 (PU2 and higher)

Customization Zip Files — for Sage 2021.2, 2022.2, 2023.0, 2023.1, 2023.3 & 2024.0
- TaiRoxXLOrderEntry _202n_n.zip, TaiRoxXLShipmentEntry _202n_n.zip

Note: The installation package also contains “Setup-2012-2017.msi” to install
Productivity Tools for Sage 300 2012-2017 or lower.

Schedule an outage with enough time to complete all installation/update steps.
Note that all users must log out of Sage 300 as the first step of an outage. Consider
whether or not you wish TaiRox resources to be available during the outage.

O 0O 0O 0O O O O ©O

Note: TaiRox will review any outage plan at no charge prior to the outage if received
several days prior to the outage.

Steps for Updating to Productivity Tools 2018-2025

Productivity Tools includes Sage Desktop and Web Screens installation programs as well as
customization zip files for Sage 300 Web Screens.

TaiRox Productivity Tools for Sage 300

Setup-2018-2025.msi — installs the Productivity Tools programs on the Sage Desktop.

TPTWeb_202n_n_setup.msi — installs web screens for TaiRox Productivity Tools.

Productivity Tools Web Screens are launched from Sage 300cloud running in a Web
browser. You must install them on the server where Sage 300 Web Screens are
installed.

Sage 300cloud Web Screens are version-specific. You must install TaiRox Web
Screens that match your version of Sage 300.

TaiRoxXLOrderEntry 202n_n.zip and TaiRoxXLShipmentEntry_202n_n.zip --
installs customizations to Sage 300 web screens — such as the SmartFinder for looking
up customers on the Order Entry screen and the optional fields that appear on the Order
Entry customer tab.

You import TaiRox Productivity Tools customizations for Sage 300 Web Screens using
the Sage 300 Web Screen Admin Configuration application.

© TaiRox Software Inc. All rights reserved.
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Copy customization files for your version of Sage 300 to the server desktop so you can
find them during installation.

To install / update Productivity Tools:

1.
2.

TaiRox Productivity Tools for Sage 300

Have all users log out of Sage 300 — Web screens and Sage 300 Desktop.

Uninstall prior versions of “TaiRox Productivity Tools” from all computers running Sage 300
applications.

For instructions on uninstalling applications, see Uninstalling Productivity Tools.

If you previously installed the Web Screens, uninstall “TaiRox Productivity Tools Web
Screens” from all computers running Sage 300 applications.

Run “iisreset” after uninstalling a prior version of Productivity Tools Web Screens, and
clear your browser’s cache of temporary Internet files.

Install the new version of Productivity Tools software on all computers running Sage 300
applications using the following installation file.

Setup-2018-2025.msi

This program installs the new version of TaiRox Productivity Tools for the Sage 300
Desktop. For installation screen details, see Screens: Installing Productivity Tools.

After installing, you must also run RegAcc.exe on each workstation that runs Sage 300
from a server (or run Workstation Setup with “repair”).

If this is a new installation, sign in to Sage 300 as an administrator and set up the program:

- Activate the new version of Productivity Tools. For details, see Activating TaiRox
Productivity Tools.

- On the Sage 300 Desktop, go to the Productivity Tools folder, open the License
Information program, and enter the TaiRox license information.

» Accounts Payable R
» Accounts Receivable TaiRox Productivity Tools (License Information)
S lLicensed to: Don Thomson, TAIROX SOFTWARE INC
» Common Services Dealer:
» General Ledger o
Intelligence Reporting
> Inventory Control
» Order Entry
. General Ledger Tools  Order Entry Tools  Purchase Order Tools  Inventory Control  Accounts Receivable
» Project and Job Costing Tools Tools
» Purchase Orders
S0X Check Approval —_— —_—
TaiRox CRM and Collecti {\-'J {! {!
2 e e e T Accounts Payable  Multi-Company Toals | License Information Options Convert Contacts
I » TaiRox Productivity Tools I Tools
Sage  ForHelp, press F1 [£5] Session Date: 2021-03-29
=

Note: The Company Name for the TaiRox license must exactly match the name of
the company in the Sage 300 License Manager — including capitalization,
punctuation and spacing.

- Open the Options program to specify which Productivity Tools you want to display on
the Sage 300 Desktop.
Note that these settings do not affect the menus for Web Screens.

- Review the Productivity Tools documentation for information on other settings that
affect individual Productivity Tools.

© TaiRox Software Inc. All rights reserved.
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- Set up Security Groups and User Authorizations for Productivity Tools if you use
security with Sage 300.

If you do not use Sage 300 Web Screens, you have completed the installation and
setup steps for TaiRox Productivity Tools.

For more information, select the User Guide from the Productivity Tool's Help menu.

User Guid
e » M Q+ No. of Shipments D| Last Shipment No.
License Information...
E | | Last Invoice No.
E TaiRox Home Page
About... PO MNo. | ‘ |Sta1us | ‘Emered By:

6. Install Productivity Tools Web Screens using one of the following installation files:

Sage 300cloud web screens are version-specific. You must install web screens that match
your version of Sage 300 — such as 2022.2 or 2024.0.
TPTWeb_2024_0_setup.msi
Installs the Web Screens for Productivity Tools for Sage 300 version 2024.0 (original
release).
TPTWeb_2023_3_ setup.msi
Installs the Web Screens for Productivity Tools for Sage 300 version 2023.3 (with PU3).

TPTWeb_2023 1_setup.msi
Installs the Web Screens for Productivity Tools for Sage 300 version 2023.1 (with PU1).

TPTWeb_2023_0_setup.msi

Installs the Web Screens for Productivity Tools for Sage 300 version 2023.0 (original
release).

TPTWeb_2022 2 setup.msi

Installs the Web Screens for Productivity Tools for Sage 300 version 2022.2 (with PU2
or higher).

TPTWeb_2021_2 setup.msi

Installs the Web Screens for Productivity Tools for Sage 300 version 2021.2 (with PU2
or higher).

7. Delete any existing Productivity Tools customizations from prior versions.
- Login to the Sage 300 Web Screen Admin Configuration application.
<web server>/Sage 300/Admin

- Delete prior versions of Productivity Tools Web Screen customization. (Select it from
the Package ID dropdown and click the Delete button.)

8. Import new customization packages for Productivity Tools. See the next section, Installing
Sage 300 Web Screen Customizations, for details on importing customization packages.

For example —to import customizations for Sage 300 version 2024.0, use zip files
TaiRoxXLOrderEntry 2024 _0.zip and TaiRoxXLShipmentEntry 2024_0.zip
- Login to the Sage 300 Web Screen Admin Configuration application.

<web server>/Sage 300/Admin

- Delete any previous versions of Productivity Tools Customization Packages by
selecting them from the dropdown, and clicking the Delete button.

TaiRox Productivity Tools for Sage 300 5
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Installing Productivity Tools Steps for Updating to Productivity Tools 2018-2025

- Use the Browse button to find new customization package zip files.
- Use the Import button to import them.
- Use the Assign button to assign them to Sage 300 company databases.

Run ‘iisreset” after installing the Productivity Tools Web Screen customizations and
clear your browser’s cache of temporary Internet files.

See Clearing Your Browser Cache After Installing Customizations.

Import all customization packages for your version of Sage 300 that are included with
the Productivity Tools installation package.

TaiRox Productivity Tools for Sage 300 6
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Appendix A: Installing Web Screen Customizations

Follow these instructions to import the Web Screen customization packages for Productivity
Tools. Customization packages add features to the standard Sage 300 Web screens — such as
the Customer SmartFinder and Optional Fields added to the Sage 300 Order Entry program.

To install Web Screen customization packages for Sage 300cloud:

¢ Install the latest version of Productivity Tools and Productivity Tools Web Screens.

e Copy the customization zip files for Productivity Tools (for example,
TaiRoxXLOrderEntry 2024 0.zip) to a convenient location on a Sage 300 Web Server.
You will need to find them easily to import them.

Make sure that you copy the customization files that match your version of Sage 300.

e Open your browser and browse to <Sageserverlinstance>/Sage300/admin to open the
Sage 300 admin portal.

S Sage300 x

& G @ @] localhost/Sage300/admin

300 ‘
Sign In to Sage 300 ‘

(Admin Configuration)

ADMIN

[ sausvs E L} 0 TnslP. h ~au

e Select the System database, and sign in with an Admin password.

On the Import Customization Packages screen:

o Click the Browse button and find a Customization zip file (for example,
TaiRoxXLOrderEntry 2024 0.zip).

300 signow (D)

|
|
i

Import Customization Packages

Import | Manage

A B> ThisPC 5 Desktop >

Organize v New folder

Custonjization Details
A Name

# Quick access
OpenOffice 4.1.7 (en-US) Installation File
I Desktop » P (en-US)
Sage 300 2020 PU3
!Dawn\aadx * o TaiRex
[£ Documents

& Pictures.

| Sage300

To Delete a prior customization first, select the prior customization from the Package
ID dropdown, and click the Delete button.

TaiRox Productivity Tools for Sage 300 7
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¢ Double-click the zip file to select it, and click the Import button.)

Import Customization Packages

Package ID * Package Description

‘ 16c4226a-62b2-470d-acfd-ffcb22250ac3 ‘ - ‘ Extended Order Entry

Browse Import

o Click the Assign button at the bottom of the Import screen, select the companies that use
TaiRox Productivity Tools, and click OK.

m_ — —_—

Extended Order Entry TaiRox Et TaiRox 10

|| Company Descr

SAMINC

SAMLTD Sample Company Ltd
O TSTITD TSTUTD

puse[ 1 ]t 1ttt

E —

¢ Import the next customization package — e.g., TaiRoxXLShipmentEntry 2024 0.zip.

o Follow the instructions above until you have imported and assigned all Productivity
Tools customization packages.

After you have imported and assigned all customization packages:
¢ Sign out of Sage 300 and exit the browser.

e Open a command prompt and enter iisreset to restart iis. You may have to run the
command prompt “As Administrator” to have sufficient permissions.

[ Administrator: Command Prompt

ion 6.1.76811
icrosoft Corporation. A1l rights reserved.

ecessfully stopped
ssFully restarted

I Open file location

o Verify the installation by signing in to the Sage 300 portal and opening the Order Entry
program.

& Session Date: Mar29,2021  Adminisiralor »  Sample Company Lid. Q @ & 7
Seach  Hep  Sefigs Tooks

>

OIE Transactions : OrderEntry ~ ShipmentEntry  Invoice Entry  CreditiDebit Note. Copy Orders

g
OIE Order Entry options £ [ O E

*Required

@ Order Summary
Number of Shipments 0 n

Last Shipment Number

Order Number

) B G

| I

Last Invoice Number

In this case, you can see and test the link for the Customer SmartFinder on the Sage
300 Order Entry Web screen.

TaiRox Productivity Tools for Sage 300 8
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Appendix B: Clearing Your Browser Cache

Note that all users should clear their browser caches when
you update to a new version of Sage 300 or TaiRox Web screens.

Follow these instructions to clear the cache on different browsers:
Microsoft Edge

€83 Settings

<« G @ @ tdge | edgey/settings/privacy

Settings Tracking prevention @

Websites use trackers to collect info about your browsing. Websites may use this info to improve sites and show yout« & indow  Ctrl+ShiftN
Search settings
Q. Search settings personalized ads. Some trackers collect and send your info to sites you haven't visited.

Zoom — % 4 2
= Tracking prevention = Favorites Ctrl+Shift=0
|| () Privacy, search, and services
o) CtrleH
Q) Appearance @ Balanced
. - 4 Ctri=
() Onstartup . sites you rs. ® N
New tab page
5] pag likely be I e}
@ Share, copy, and paste
Ctrl-Shift¥
3 Cookies and site permissions
E s Blocks known harmful tracks
£§ Default browser Ctrl+p
L Downloads Blocked trackers @ webcspture CtrleShift=5
& Family safety View the sites that we've blocked from tracking you
At Languages Exceptions &) Find on page Ctrl-F
© Frinters Allow alltrackers on sites you choose
O System Always use “Strict” tracking prevention when browsing InPrivate More tools >
) Reset settings | 3 Settings

[ Phone and other devices Clear browsing data @ Help and feedback >

@ About Microsoft Edge This includes history, passwords, cookies, and more. Only data from this profile will be deleted. Manage your data

Close Microsof
Clear browsing data now Choose what to clear

Choose what to clear every time you close the browser >

Click the Settings and More button in the upper-right corner to display the menu.
Select Settings from the Menu.

Select Privacy, Search, and Services from the Settings Menu.

Scroll down to Clear Browsing Data.

Click the Choose What To Clear button.

Select a Time Range of All Time.

N o ok obh =

Check Cached Images and Files. You can uncheck the other data if you want to keep
it.

8. Click the “Clear Now” button.
9. Close ALL Edge browser windows
10. Restart Edge and sign on to Sage 300 again.

TaiRox Productivity Tools for Sage 300
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Internet Explorer

-

N
| < ntemet Options (2 ]

() Start with tabs from the last session
@ Start with home page
Tabs

Change ho nebpages are dsplayed n tabs.

[ Delete browsing history on exit

Appearance

Colors ][ Languages ][ Fonts H Accessibility ]

[oc [ concl J[ oo ]

Select “Internet Options” from the

> w N =

orts  Entertainment  Lifestyle Heal
Browsing history
Delete temparary files, history, cookies, saved passwords, and web
form information. i

'EGHSear:h‘.‘ D-\G&“«ﬂ
a Print v
S senera F=curity | privacy | content | comnections | Programs [ Advanced| m
File »
Home page Zoom (75%) v
To create h tabs, ch add) its own lne.
@ 0 create home page tabs, type each address on its own line. Safety .
http://www tairox.com/ s
Add site to Start menu
View downloads Ctrl+)
[ useaurent | [ usedefaut | [ usenewtsb Manage add-ons
Startup F12 Developer Tools

f
Facsbook

Go to pinned sites

Compatibility View settings

Report website problems
Internet options

3

Home hacks that
everyone wishes they
knew sooner

menu.

Check/select only the following items on the list:

o Preserve Favorites Website data
o Temporary Internet Files and Website files

Uncheck/deselect the rest of the items on the list, especially the Passwords item.

Click Delete.

ABout Internet Explorer

] 1]
Ridiculously funny home
renovation fails

Go to the Tools menu (click button in the upper-right corner to display the menu).

Under the General tab, Browsing History section, click on the Delete button

Wait for the message Internet Explorer has finished deleting the selected browsing
history to appear at the bottom of the page.

8. Click Apply.
9. Click OK.

10. Close ALL Internet Explorer browser windows.

11. Restart Internet Explorer and sign on to Sage 300 again.

Google Chrome

£ Settings

&« C @ Chrome | chrome://settings/privacy

Settings Q,  Search settings

2 Youand Google
< Privacy and security

B  Aubofill

_ Clear browsing data
@  safetycheck B Clear history, cookies, cache, and more

e Privacy and security & Cookies and other site data

Third-party cookies are blocked in Inco

gnito mode

@  Appearance
Security
Search engine
© 9 Q o Browsing (protection from dangerous sites) and other security settings

nito window  Ctrl+S|
History
Downloads
Bookmarks
Zoom - 100% -+
Print..
» Cast.
Find..
More tools

Edit Cut Copy

CirlsT
CirleN
hift=N

Crl+P

Crl+F

Paste

B Default browser
_, Sitesettings

TaiRox Productivity Tools for Sage 300
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Click the Settings button (in the upper-right corner of the browser window).
Select Settings.

Select Privacy and Security on the Settings menu.

Click Clear browsing data.

Select All Time on the dropdown menu.

2B o

Check/select the following item on the list:

o Cached images and files

7. Uncheck/deselect the rest of the items on the list, especially the Passwords item.
8. Click the Clear data button.

9. Close ALL Google Chrome browser windows

10. Restart Google Chrome and sign on to Sage 300 again.

Mozilla Firefox

3% Options
PR RN I © Frefor  sboutpreferences#privacy o n o e E
S sage 300 @ Signin to Firefox >
- ldn Protections Dashboard
Find in Options
B New Window Ctrl+N
. . ©3 New Private Window Ctrl+Shift+P
'ﬁ’ General Cookies and Site Data
B3 Restore Previous Session
ﬁ‘ Your stored cookies, site data, and cache are currently using 151 MB of disk Clear Data...
Home - -
space. Learn more Zoom ) + | 2
Manage Data...
Edit
Q Search ) 3 § .
Delete cookies and site data when Firefox is closed Manage Exceptions...
- TN\ Library >
a Privacy & Security w0 Logins and Passwords
"~ Add-ons Ctrl Shifts A
K/ Sync Logins and Passwords i Options
Ask to save logins and passwords for websites Exceptions... »7 Customize.
i Open File.. Ctrl+0
Autofill logins and passwords Saved Logins.. P
Save Page As.. Ctrl+S
Suggest and generate strong passwords
& Print.
Show alerts about passwords for breached websites Learn more
Q Find in This Page... Ctrl+F
Use a Primary Password Learn more More >
Formerly known as Master Password Web Developer >
o8 What's New >
@ Help >
O Bt Ctrl+Shift+Q
History
Firefox will  Remember history ~
& Extensions & Themes
Firefox will remember your browsing, download, form, and search history. Clear History...
® Firefox Support
s ©

Click on the menu button (three bars in the upper-right corner of the browser window).
Select Options.

Select Privacy and Security from the Options menu.

Scroll down to the History section and click the Clear History button.

For “Time Range to Clear”, select Everything.

o a kb=

Check/select only the following item on the list

o Cache

Uncheck/deselect the rest of the items on the list, especially the Active Logins item.
Click the OK button.

TaiRox Productivity Tools for Sage 300 11
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9. Close ALL Mozilla Firefox browser windows

10. Restart Mozilla Firefox and sign on to Sage 300 again.

Apple Safari

iew History Boockmarks  Window  Help

Ctri+Z Applelnc. @ ¢ | [ Q- Google | O -
Crl+ Shift+Z Tube Wikipedia News (38) v Popular v

Cut Ctrl+ X -~
Copy Ctrl+C

Paste Ctrl+V e ep

Delete Del

Select All Cirl+A nline and get Specialist help, free no-contact delivery, and more.

AutoFill Form Ctrl+Shift+ A

Find 4

Spelling and Grammar 4

iPhone 12

Reset Safari...

By G Ctrls Alt+E Blast past fast.
| BEeElEpeIpiiberns GHes i From $29.12/mo. or $699 before trade-in.!
Preferences... Ctrl+,

uy directly from Apple with special carrier offers.

1. Select Edit on the menu bar.

Select Empty Cache.
Click Empty.

Are you sure you want to empty the cache?

Safari saves the contents of webpages you open, and stores them in

;@ a cache, so the pages load faster when you visit them again.

I\T‘/I Emp Cancel

4. Close ALL Apple Safari browser windows

5. Restart Apple Safari and sign on to Sage 300 again.

TaiRox Productivity Tools for Sage 300
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Uninstalling Productivity Tools

Appendix C: Desktop Installation Program Details

Uninstalling Productivity Tools

To uninstall Productivity Tools:

e Navigate to the Windows Control Panel, click on the Programs and Features link and
select TaiRox Productivity Tools from the list of installed programs.

[F=3 =0 )
@U=|B v Control Panel » All Control Panel tems » Programs and Features - |#7 | | Search Programs and Features g |
Control Panel Home .
Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
® Turn Windows features on or
it Organize *  Uninstall Change  Repair 4= - IZ:ﬂ:I
Name ’ Publisher Installed On  Size o
% TaiRox Fast Data Integrity Console TaiRox Software Inc. 4/5/2018 27
% TaiRox Fast DBTools TaiRox Software Inc. 3/21/2018 114
% TaiRox Optional Field Manager TaiRox Software Inc. 3/16/2018 104
: % TaiRox Productivity Tools TaiRox Software Inc, 8/15/2018 574
% TaiRox 50X Backup Enterprise TaiRox Software Inc. 5/25/2018 19.
% TaiRox 50X Second Sight TaiRox Software Inc. 10/10/2017 49
%% TaiRox 50X User Management TaiRox Software Inc. 10/10/2017 1.7]
=7 Visual Studio 2010 Prerequisites - English Microsoft Corporation 10/5/2017 23|
ﬁ‘u‘l\dware Tools VMware, Inc. 10/5/2017 100 -
] 1 b
— TaiRox Software Inc. Product version: 1.0.0 Support link: http://www.tairox.com
"\_J Help link: http://www.tairox.com Size: 576 MB

¢ Double-click the entry for TaiRox Productivity Tools.

OR

e If available, double-click the distribution file that you used to install Productivity Tools
(either Setup-2018-2025.msi or Setup-2012-2017.msi, depending on your version of

Sage 300).

o Select “Remove TaiRox Productivity Tools” on the screen that appears, and click the

Finish button.

ﬁ TaiRox Preductivity Tools

ol = =]

Welcome to the TaiRox Productivity Tools Setup LA
Wizard Aeidy

Select whether you want to repair or remove TaiFox Productivity Tools,

< Back

TaiRox Productivity Tools for Sage 300
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Appendix C: Desktop Installation Program Details

Screens: Installing Productivity Tools
Productivity Tools use standard Windows installation programs.

If you are running Sage 300 2020, 2021, 2022 or 2023, you can also install the Web
Screens after installing Productivity Tools for the Sage 300 Desktop.

Step 1: Welcome

Double-click “Setup-2018-2025.msi” or “Setup-2012-2017.msi”, depending on your

version of Sage 300.
A welcome screen will appear.
Click the Next button.

The installer will guide vou through the steps required to install TaiRox Productivity Toaols on pour
caomputer.

WARMIMG: This computer program is protected by copyight law and intemational ireaties,
Unauthorized duplication or distribution of this program, or any portion of it may result in severe civil
or criminal penalties. and will be prosecuted to the maximum extent possible under the law.

Cancel < Back

ﬁ TaiRox Productivity Tools EI = @
Welcome to the TaiRox Productivity Tools Setup LA
Wizard st |

Step 2: License Agreement

On the second screen, you must accept the license agreement terms before proceeding.

Select the “I Agree” radio button and click the Next button.

License Agreement [

Pleaze take a moment to read the license agreement now. |f pou accept the terme below, click
Agree', then "Newt”. Otherwize click "Cancel”.

[PORTANT NOTICE: This End-User License Agrsement ("EULA") is a legal agreement
between you (“Licensee”, either an individual or a single entity) and TaiRox Seftware Inc.
(“Publisher”) for the software and electronic documentation (“Software™) that accompanies
this EULA. LICENSEE AGREES TO BE BOUND BY THE TERMS OF THIS EULA

BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE.

1. GRANT OF LICENSE. Subject to the terms and conditions of this EULA, including, but
not limited to the condition that Licenses will not attempt to subvert or disable any license
mechanism built into the Software, Publisher grants Licensee the right to install and use the
Software on one or more workstations, laptops, servers or other devices (“Computers™) at

| Do Mot Agree @ | Agree

| Cancel | | < Back | | Next »

j@ TaiRox Productivity Tools EI = \EI

Step 3: Confirm Installation

Click the Next button to start the installation.

TaiRox Productivity Tools for Sage 300
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Appendix C: Desktop Installation Program Details

ﬁ TaiRox Productivity Tools EI = \EI
Confirm Installation A

The installer iz ready ta install TaiRox Productivity Tools on pour computer.

Click "Next" to start the installation

[ Cancel ] [ < Back ] | Mext »

Step 4: During Installation

A screen with a progress bar will appear for a few seconds.

‘i@ TaiRox Productivity Tools EI = @
Installing TaiRox Productivity Tools A

TaiRox Productivity Toals is being installed.

Please wai...

Step 5: Installation Complete

When installation is complete, the following screen will appear.

e Click the Close button to exit.

‘ﬁ!TaiRm( Productivity Tools EI = \EI
Installation Complete LA

TaiRox Productivity Toals has been successiully installed.

Click. "Cloge" to exit.

Please uze Windows Update to check for any critical updates to the .MET Framework.

TaiRox Productivity Tools for Sage 300
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Appendix C: Desktop Installation Program Details

Activating Productivity Tools

Once you install Productivity Tools, you must activate it just like any core Sage 300
application.

You must activate it in all companies for which you want to use Productivity Tools.

= TSTLTD - Data Activation - o x
FEile Settings Help

Applications for Activation

[#] Accounts Payable 6.8A

[[] Customer Number Change 6.8A

[] G/L Consolidations 6_8A

[] Intercompany Transactions 6.8A

[] kem Number Change 6.8A

[[] Sage Fixed Assets Integration 6.8A
[[] Vendor Number Change 6.8A

[[1SOX Check Approval 2018-2021 6.5A

< TaiRox Productivity Tools 6.1A >
T ——

< Previous Next > Activate Close

TaiRox Productivity Tools for Sage 300
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